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Integration Note 

Manufacturer: PCS PulseWorx UPB Lighting 

Model Number(s): Various (See table) 

Comments: See Core Module Revisions required in Model Number table 

Document Revision Date: 1/15/204 

IMPORTANT: UPB products DO NOT work well with Lutron HomeWorks, RadioRA or GRAFIK Eye.  

Contact PCS if you have a job that requires both systems in the same building. 

SUPPORTED FEATURES 

PCS PULSEWORX LIGHTING SYSTEMS SUPPORT THE FOLLOWING FEATURES: 

Powerline Communications: No dedicated low voltage wiring to control switches or keypads. 

Switch Control: Control of individual loads from virtual and simulated keypads on the Viewer Interface. 

Link Control: Control of PCS Links (scenes) from virtual and simulated keypads on the Viewer Interface. 

LED control: Gen1 devices LED state may be controlled appropriately from the g! system. (Enable LED 
Management in Configurator). 

Schedule Control:  Multiple schedules can be set using the Viewer software. The schedules are tied to 
the house mode. 

Automatic System Detection: The g! system will automatically detect all the switches, keypads and links 
in the system either by reading the network or by importing the exported UPE file (g! version 6.5 required). 

Support for Inputs and Outputs: The ICM (Input Control Module) and OCM (Output Control Module) 

allow the g! system to provide support for inputs (voltage or contact closure) and outputs (contact closure, 
24VAC at 8A). 

Support for Multi Phase Power: Phase Coupler/Repeater modules are available and may be used when 
controlled from g! Note that Multi-Packet control must be enabled, and cannot be used during discovery. 

RS232 or IP Control: The PIM-R for RS232, PIM-IP (g! Version 6.5 required), and PCS PulseWorx UPB 
Gateway are compatible for control with the g! system. These devices allow g! two-way communication for 
control and feedback of UPB devices. 

Single Device Discovery: g! Version 6.5 allows a single PCS ID to be discovered in Configurator. 

Customizable Scene Support: g! Version 6.5 adds a new form of Customizable Scene which may be 
connected to a PCS Link. Changes made in the PCS Customizable scene are written to the PCS devices. 

Devices Supported: The following table lists the devices that are currently supported: 

Model Number Description Core Module Required 

WS1D-6, 10, 15, 24 600 to 2400 watt wall switch 4.0 

RWS-S, RWS-H Standard and high power remote 
switch 

4.0 

WMC6, WMC8 6 and 8 button wall mount controllers 4.0 

DTC6, DTC8 6 and 8 button desk top controllers 4.0 
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PIM-R RS-232 Serial Powerline Interface 
Modules 

4.0 

LM1-4 One channel lamp module 4.0 

ICM, OCM Input Control Module, Output Control 
Module 

4.0 

AM1 Appliance Module 4.0 

KPC6, KPC8 Gen2 6 and 8 button keypads 4.0 

FMR, FMD Fixture Module – Dimmer or Relay 5.2 

LM2-8 Two channel lamp module 5.2 

KPLD6, KPLD8 Hybrid Dimmer and 6 or 8 button 
keypad 

5.2 

KPLDR6, KPLR8 Hybrid Relay and 6 or 8 button keypad 5.2 

WS1DL LED/CFL Dimmer 6.2 

WS1R 10 or 20 Amp Relay Wall switch 6.5 

KPC7 7 Button Keypad 6.5 

PIM IP Ethernet PIM  6.5 

PCS PULSEWORX LIGHTING SYSTEMS DO NOT SUPPORT THE FOLLOWING FEATURES: 

Discovery using Multi-Packet: While PCS may be controlled appropriately with Multi-Packet enabled, 
Discovery of the lighting devices must be done in Single-Packet mode. 

Limitations with Lighting Global Control and some PCS Devices: The Lighting Global Control will not 
show correct state for PCS links in all cases. Hybrid Keypad devices will not display on the Lighting Global 
Control. 

Other PIM types: Only the PIM-R RS-232 or PIM-IP Powerline Interface Module is compatible for 
discovery and control from a HC Controller. Other models such as the PIM-U are not compatible. It is 
recommended to connect PCS PIM-R to Com 1 or 2 on the HC controller. 

PIM-R on Global Cache: The PCS PIM module is not compatible with a COM port on a Global Cache.  

Button Types: UPStart may program PCS devices to do many things based on types of button press 
(double tap, press and hold etc). These modes are not integrated into the g! Viewer, and all buttons will 
act as “Link Activator”, “Toggle” or “Bright/Dim” as appropriate from the g! Viewer interface. Special button 
type settings should still work from the physical switches, but not from the Viewer. 

Button Press: UPB devices do not transmit to g! based on button press, and g! cannot event map off a 
button press. UPB devices only send events for scene/load on/off. 

LED Control (GEN2 Devices): GEN2 PCS devices do not support LED control, and LED Management 
should be disabled in Configurator. Properly configure Indicators in the Properties for each Keypad in 
UPStart instead. See UPStart/Pulseworx documentation for details. In addition, note that special LED 
tracking types (Room Tracking, for example) are not supported in the g! system.  

Any feature not specifically noted as “supported” is not supported. 
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OVERVIEW 

Installing a PulseWorx lighting system can be broken down into the following steps:  

1. Work with the client to determine what lights will be controlled, where switches will be installed, and 

where keypads will be installed.  See Suggested Design Procedure below. 

2. Install and test each of the switches and keypads to confirm proper wiring.  See Installation 

Overview for the list of steps required. 

3. Program and test the lighting system for proper keypad and scene function.  This process is 

discussed in Programming Overview below, and includes first offline and then online programming 
of the system. 

4. Integrate the lighting system into the g! system and test proper operation. This step is outlined in g! 

Configuration Details. 

 

SUGGESTED DESIGN PROCEDURE 

The following steps illustrate one approach to work with a client to arrive at a lighting system design that 
can be implemented successfully with PulseWorx. 

STEP 1: ORGANIZE THE LOADS INTO GROUPS 

The first step is to put all the switches into groups: one group for each primary space or function.  Typical 
groups include: 

 Outside Lights: these are loads around the perimeter of the house that normally are controlled 
by switches scattered about at various locations. 

 Pathway Lights: these are loads that provide the basic lighting to move around the house.  
Loads include the front door, the entry hallway, stairwells, the garage entryway, etc. 

 Family Room Lights: these are loads in a room that combine to create a mood or atmosphere.  
Often there are numerous switches ganged at one location or ganged at several locations. 

STEP 2: DECIDE HOW KEYPADS CONTROL EACH GROUP 

Once you have the switches in groups, decide what the home owner will want to do with each group.  The 
result of this step is a list of keypads (6 button or 8 button), and the desired behavior for each button.  
Each keypad button is assigned as a scene or a toggle (remote switch): 

 Scenes: each scene turns a group of lights on to specified levels.  Scenes are most 
commonly used in spaces like family rooms and kitchens. 

 Toggles (Remote Switches): these are controls that allow the home owner to turn on lights 
from anywhere in the house, and are most commonly used for outside lights (turn on the front 
door light) or remote lights (the basement light). 

This process is probably the most important step, and should be done with the client’s input.  Here are 
some examples to help illustrate: 

 Outside Lights: Place a keypad by the front door and the back door. Both will behave the 
same, and include buttons for: 

o All On: Turn on all the outside lights. 

o Evening: Turn on the normal lights that illuminate the driveway and front door. 

o Party: Turn on the yard spot lights and accent lights that highlight the landscaping. 

o All Off: Turn off all of the outside lights. 

 Kitchen: Place a keypad in the kitchen with buttons for: 
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o All On: Turn on all of the lights in the kitchen. 

o Evening: Turn on just the lights for a normal evening. 

o Cook: Turn on the lights needed to cook and prepare dinner. 

o Dine: Turn on the lights over the dining table, and dim the lights in the kitchen to provide 
the appropriate dining atmosphere. 

o Late Night: Turn on the under-counter lights just enough to be able to walk around in the 
middle of the night. 

o All Off: Turn off all of the lights in the kitchen. 

 Basement Light: Add a single button on one of the keypads in the house to remotely control 
the basement light.  The keypad button is illuminated when the light is on. 

 Master Keypad: Place a keypad in the master suite with buttons for: 

o Outside All On: Turn on all of the outside lights. 

o Outside Evening: Turn on normal evening lights. 

o Outside All Off: Turn off all of the outside lights. 

o Inside All On: Turn on all of the inside lights. 

o Inside Evening: Turn on the normal evening lights: Kitchen Evening and Pathway lights. 

o Inside Late Night: Turn on pathway lights just enough to get around during the night. 

o Inside All Off: Turn off the inside lights. 

STEP 3: PREPARE YOUR BILL OF MATERIALS 

The results of the first two steps are lists of switches, remotes and keypads along with a list of the desired 
behavior / commands for each lighting group. 

For each switch, calculate the total load on the circuit: this will determine which switch / dimmer is needed 
at each location. 

For each location, be aware that the 1500 and 2400 watt switch dimmers have a thicker heat sink, and to 
sit cleanly in a multi-gang box, should be installed with other similar switches.  The “high power” remotes 
have the thicker metal, and are designed to mount with the high power switches, whereas the “standard” 
remote is designed to mount with the 600 and 1000 watt switches. 

In addition to your list of required switches, refer to the Connection Diagram and Bill of Materials below 
to determine an overall list of required parts for the installation. 

STEP 4: PREPARE YOUR LIST OF LINKS 

In a PulseWorx system, all lighting commands are ultimately reduced to links, and in PulseWorx 
documentation, the terms “scene” and “link” are often used interchangeably.  A link is a lighting command 
that causes specific switches to change their state.  If a switch is supposed to respond to the link, we say 
the switch is “enrolled” in that link.  Links are identified by a number, or “Link ID”.  Link IDs start at 1 and 
increment upwards in sequence. 

Links are either “scenes” or “toggles”, as described above.  In UPStart, a scene is referred to as a Link 

Activator, and a toggle is called a Toggle Button. If a link is used on more than one keypad, make sure it 

is set as a Toggle Button on both, or a Link Activator on both. 

If you are using the input or output module (ICM, OCM), then add links for each input and output.  For 
example, if you have one ICM and one OCM, then add links for Input1, Input2, Output1 and Output2.  
Links for the input module are either normally open or normally closed, and have corresponding link 

modes of N.O. Input and N.C. Input.  Links for the output module don’t have a mode. 

Using the examples above, our link list would look something like this: 

Link ID Link Type (Mode) Room / Group Link Name 

1 Link Activator Outside Outside: All On 

2 Link Activator  Outside: Evening 
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3 Link Activator  Outside: Party 

4 Link Activator  Outside: All Off 

5 Link Activator Kitchen Kitchen: All On 

6 Link Activator  Kitchen: Evening 

7 Link Activator  Kitchen: Cook 

8 Link Activator  Kitchen: Dine 

9 Link Activator  Kitchen: Late Night 

10 Link Activator  Kitchen: All Off 

11 Toggle Button Basement Basement 

12 Link Activator Inside Inside: All On 

13 Link Activator  Inside: Evening 

14 Link Activator  Inside: Late Night 

15 Link Activator  Inside: All Off 
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INSTALLATION OVERVIEW 

Once the system has been designed, the following steps are needed for installation. 

IMPORTANT: Contact PCS for help with installations involving three-phase power. 

Refer to the diagrams that follow for various wiring scenarios. 

1. Rough-in the high-voltage electrical wiring for the lights as though you were using standard light 
switches. 

2. For single-phase installations, during the electrical rough-in, at a convenient location, add a single-
gang outlet box for the RS-232 PIM (Powerline Interface Module). 

3. Run a Cat5 cable from the PIM to the g! system.  If the PIM is installed in a finished wall, then you 
may wish to add a single-gang outlet adjacent to cleanly terminate the Cat5 to an RJ45 Female 
connector. 

4. Install the PCS PulseWorx switches, remotes, keypads, Phase Coupler/Repeater (as needed) and 
PIM to PCS standards. 

5. Power up the switches and keypads. 

6. Switches and remotes come from the factory with default settings as listed below.  Test the switches 
and remote switches to confirm that the appropriate load turns on and off as expected.  Use the 
double-tap for any loads that should not be dimmed. 
 

Double-Tap Top Instant On (No ramp up) 

Tap Top Turn On 

Hold Top Dim Up 

Hold Bottom Dim Down 

Tap Bottom Turn Off 

Double-Tap Bottom Instant Off (No ramp down) 

7. Keypads come from the factory with default settings as listed below. Press the buttons on the keypads 
to ensure proper function. IMPORTANT NOTE: Until properly programmed, pressing a keypad button 
will turn on or off all the lights in the house.  
 

On Button 100% (All the way on) 

A Button 80% 

B Button 60% 

C Button 40% 

D Button 20% 

Off Button 0% (All the way off) 

8. Terminate and test the Cat5 cable from the PIM to the g! system. 
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CONNECTION DIAGRAM- RS232 

The diagram below shows an overview of a typical system.  Refer to the Bill of Materials for additional 
detail, including specific part numbers. 

On the following pages we have included more detailed wiring diagrams for common switch and keypad 
installation scenarios. 
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BILL OF MATERIALS  

# D evice M anufacturer P art  N umber P ro to co l C o nnecto r T ype N o tes

1 Load Various N/A N/A Pigtail

2 14-2 or 12-2 Romex Various N/A N/A Pigtail

3 14-3 or 12-3 Romex Various N/A N/A Pigtail

4 Wall Switch PCS WS1D-6, 10, 15, 24 UPB Pigtail

5 Remote Switch PCS RWS-S, H UPB Pigtail

6 6 Button Keypad PCS WM C6 UPB Pigtail

7 8 Button Keypad PCS WM C8 UPB Pigtail

8 Breaker Box Various N/A N/A Terminal Strip

9 Passive Phase Coupler PCS PPC-1 UPB Pigtail

PIM -R UPB X RS-232 120VAC M ale X DB-9 Female Use for single-phase installations

11 DB9M  to RJ45 Adapter Elan HA-CB-307 RS-232 DB-9 M ale X RJ-45 Female

12 Cat5 Cable Assy. Installer N/A RS-232 RJ-45 M ale X RJ-45 M ale M ust terminate all 8 conductors

13 g! Contro ller Elan Various (ex. HC-12) RS-232 RJ-45 Female

10 Powerline Interface PCS
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CONNECTION DIAGRAM- ETHERNET 

The diagram below shows an overview of a typical system.  Refer to the Bill of Materials for additional 
detail, including specific part numbers. 

On the following pages we have included more detailed wiring diagrams for common switch and keypad 
installation scenarios. 
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BILL OF MATERIALS  

# D evice M anufacturer P art  N umber P ro to co l C o nnecto r T ype N o tes

1 Load Various N/A N/A Pigtail

2 14-2 or 12-2 Romex Various N/A N/A Pigtail

3 14-3 or 12-3 Romex Various N/A N/A Pigtail

4 Wall Switch PCS WS1D-6, 10, 15, 24 UPB Pigtail

5 Remote Switch PCS RWS-S, H UPB Pigtail

6 6 Button Keypad PCS WM C6 UPB Pigtail

7 8 Button Keypad PCS WM C8 UPB Pigtail

8 Breaker Box Various N/A N/A Terminal Strip

9 Passive Phase Coupler PCS PPC-1 UPB Pigtail

PIM -IP UPB X IP 120VAC M ale X RJ-45 Female

11 Cat5 Cable Assy. Installer N/A RS-232 RJ-45 M ale X RJ-45 M ale M ust terminate all 8 conductors

12 Switch or Router Various N/A IP RJ-45 Female

13 g! Contro ller Elan Various (ex. HC-12) RS-232 RJ-45 Female

10 Powerline Interface PCS

 

 
Note: during programming the PIM-IP should be set to a Static IP address for reliability. See details in 

Assigning the PIM-IP a Static Address. 
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WIRING DIAGRAM 1: SINGLE SWITCH, SINGLE KEYPAD 
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WIRING DIAGRAM 2: SWITCH WITH ONE OR MORE REMOTES, POWER AND LOAD IN SAME BOX 
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WIRING DIAGRAM 3: SWITCH WITH ONE REMOTE, POWER AND LOAD IN SEPARATE BOXES 
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WIRING DIAGRAM 4: SWITCH WITH MULTIPLE REMOTES, POWER AND LOAD IN SEPARATE BOXES 
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WIRING DIAGRAM 5: SWITCH WITH KEYPAD AND ONE REMOTE, POWER AND LOAD IN SEPARATE BOXES 
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WIRING DIAGRAM 6: SWITCH WITH KEYPAD AND MULTIPLE REMOTES, POWER AND LOAD IN SEPARATE BOXES 
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PROGRAMMING OVERVIEW 

The system programming can be done in two phases. 

The offline phase consists of system design and definition and is accomplished prior to installation of the 
system, with the assistance of the UPStart Setup Tool from PCS.  At the completion of this phase the 
system components (switches / dimmers and keypads), their locations, names, links (scenes) and switch 
memberships are defined. 

The online phase involves assigning component IDs and uploading the design to the physical components 
(switches and keypads).  This process is accomplished online, using the UPStart Setup Tool from PCS.  
Programming the system requires that the switches be powered up and working, and that you connect to 
the lighting system with your computer (through the RS-232 port on the PIM-R). 

THINGS TO KEEP IN MIND WITH PULSEWORX SWITCHES AND KEYPADS 

Before describing the offline and online phases in more detail, here are a few items to bear in mind when 
designing and programming the PulseWorx system: 

WORKING WITH ROOMS 

When you set up a group of switches, they should all have the same behavior.  For example, in a kitchen, 
all the lights should have the same fade rates so they dim up and down together, and they should all have 
the same LED setting so that switches in a multi-gang box look the same. 

To help organize switches, we suggest you place each group of switches from your design into its own 

Room when you add them during the programming process.  This will allow you to visually see each 
group on its own, and allow you to much more easily confirm that all the settings in a group match. 

COPYING SETTINGS 

One important feature of the UPStart Setup Tool is the ability to copy settings from one switch to another.  
After you setup your switches into Rooms, you should carefully setup the first switch in that room with the 
desired fade rates, LED settings and so on.  Then simply copy those settings to the other switches in the 
room.  

WRITING TO A UPB DEVICE 

After changing the configuration of a UPB device make sure you use the OK button to save the change 
not the X button in the upper right hand corner.  After changing the configuration of a UPB device and 
writing the data to the device make sure you use the close button and not the X button. Using the X button 
is the same as cancel and will result in a mismatch between the Network computer file and the data on the 
switch. This behavior is in version 4.15 of UPStart.  

WORKING WITH INPUTS AND OUTPUTS 

The ICM (Input Control Module) has two inputs and the OCM (Output Control Module) has two outputs.  
These devices should be thought of as modules that each contain two light switches.  For the inputs, the 
system sees that a switch (input) has been turned on or off, and for outputs the system can turn a switch 
(output) on or off.  In UPStart, the steps to configure the ICM and OCM are similar to the steps for setting 
up switches, and are described below. 

PULSEWORX FADE RATES 

There are several fade rates that can be adjusted in a PulseWorx switch: 

o Default Fade Rate: This is the fade rate that is used when you press and hold a rocker.  Setting 
this too low will make it very hard to get the right brightness, while setting it too high will force the 

user to wait a long time to change lighting levels.  We suggest a value of 3.3 seconds.  The 
Default Fade Rate is set on the Options tab in the Edit Device dialog. 

o Single-Tap Fade Rate: This is the fade rate used when you turn on or off a switch by tapping the 
rocker.  The default fade rate given above of 3.3 seconds seems slow to most people: we suggest 
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1.6 seconds.  The Single-Tap Fade Rate is configured for the top and bottom rockers separately 
on the Options tab in the Edit Device dialog. 

o Link Fade Rate: When you set up a switch, you specify the fade rate to use for each link.  This is 
the fade rate used when someone presses a scene button on a keypad.  As above we suggest 

1.6 seconds.  The Link Fade Rate is set on the Receive Components tab of the Edit Device 
dialog. 

It is very time consuming to change the fade rates for switches after the fact: we strongly recommend that 
you establish the fade rates for each group of switches before you begin programming the system.  In 
cases where you or the customer may not be familiar with the fade rate behavior, install just a few 
switches and try different settings to determine what fade rates to use. 

PULSEWORX GEN1 VS. GEN2 KEYPADS 

The Gen2 keypads (blue LEDs) have slightly different LED behavior than the Gen1 keypads (orange 
LEDs).  As a result they require a different programming method to maintain proper LED tracking between 
g! and the physical devices.  The basic difference is that with Gen1 keypads the g! software controls and 
maintains the LEDs status; with the Gen2 keypads we recommend that the PCS keypads are 
programmed to maintain LED status.  Refer to PCS documentation and the keypad receive components 

section in the Pulseworx Lighting System Programming – Offline Phase below for details. 

PULSEWORX LINKS (SCENES) DISCOVERED INTO THE g! SYSTEM 

PCS Links that are programmed to control devices within UPStart are automatically discovered into g!.  
The links are imported by their link number – not the name.  If you rename the links in UPStart be sure to 
make a table of the link names and their link number to simplify working with them after they are imported 
into g!.  Note that g! always discovers link 1 & 2 pre-labeled ALL ON and ALL OFF. 

Note: the above is only true when using network discovery. If you read in the UPE configuration file, the 
names are preserved up to 16 characters.  

EDITING UPB LINKS (SCENES) AND g! 

Prior to 6.5: PCS Links are NOT editable from the g! configurator.  Any changes to a link will need to be 
done first in UPStart and then the lighting system will need to be rediscovered (click the discover devices 

button again) in the g! configurator to enable proper synchronizing and control. Note: it is also possible to 
manually adjust levels of loads already assembled in a PCS Link. See Changing Link (Scene) Settings 
(Manual). 

g! 6.5: PCS Links may be edited from the Viewer using the PCS Customizable Scene feature. See 
complete information within g! Configuration Notes.  

ASSIGNING THE PIM-IP A STATIC ADDRESS 

The PIM-IP is strongly recommended to be set to a static IP address prior to g! integration to ensure 
reliable communication. 

1. From UPStart, click Tools and select UPB Interface Setup. 

2. With Interface Type set to PIM-IP, press the Run PIM-IP Discovery Program button. 
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3. The Device Discovery screen appears and should find the PIM-IP. Select the PIM-IP and Open 

web interface to open the webGUI for the unit and login using the configured credentials. 

 

4. Click Network to open the appropriate settings. Assign a static IP address as below and Apply to 
save changes. The first IP lighting device used with g! should be set to 192.168.0.30, the second 
to 192.168.0.31, and so on. Subnet Mask is commonly 255.255.255.0, and the Default gateway is 
typically your router IP address. The PIM-IP may reboot on Apply. 

 

Note: The PIM IP may need to be manually rebooted if you use the HC power button to shut down the HC 

controller. See Common Mistakes.
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PULSEWORX LIGHTING SYSTEM PROGRAMMING – OFFLINE PHASE 

The following assume you are working with UPStart Setup Tool version 4.2.  Some of the dialogs may be 
slightly different if you are using a different version. 

 

Step Instructions Comments 

1 Click File, New Network File to open a 
new file for your project 

This dialog asks for a Network Name, a Network ID 

and Password. The defaults are fine. 

NOTE: The Network ID is needed later in the g! 
Configurator. 

NOTE: Do not set the Network ID to 0. 

2 Click Device, Add to add switches, 
keypads, and other modules 

Set the Manufacturer and Product, and click Next.  

Then set the Room Name, Device Name and Unit ID. 

The Room Name and Device Name are used to 
organize and display the switches, keypads and 

modules: create a new Room for each group of 

switches, and set the Device Name to something 
simple yet recognizable. 

As you add additional devices, UPStart will increment 

the Unit ID so that you can start at 1 and work upwards 
in order. 

Add all switches, keypads and other modules at this 
time.  As you add them they will pop up in the tree 
structure at left. 

3 Click Network, Link Names to add and 
name the links 

Click New, then type in the Link Name.  UPStart will 

set the first Link Id to 1, then automatically increment 
for additional links. 

Add all of the links at this time. 

Note that links can cause more than one switch to 
change: in other words, they can have one or more 

switches enrolled. For example, a link named House 

All On would have every switch in the house enrolled, 

whereas a link name Pathway would have just the 
lights between the garage and the kitchen enrolled. 

4 Setup the devices in the first Room In the tree structure at left, select the first Room: this 
will display all the switches, keypads and modules from 
that room in the window to the right. 

4.1 Right-click the first SWITCH from the 

window at right, then click Edit 

This brings up the Edit Device dialog, which allows you 
to edit the settings for the switch. 

4.2 Click the Receive Components tab to 
view the links in which this switch is 
enrolled 

Enroll the switch into the required links, up to a total of 
16.  For each link: 

Set the Level. Note that changing this level later while 
at the site is easy to do at the switch, so getting it 
perfect at this time is not critical. 

Set the desired Fade Rate. 
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4.3 Click the Options tab to view the 
available switch options 

Select the desired LED Color Control. 

Confirm that Report light level after rocker switch is 

pressed is checked. 

If the light should not be dimmed, set Dimming to Not 

Enabled.  For switches that support dimming, set the 

Default fade rate. 

Set the desired single-tap and double-tap behavior, 

including the desired fade rate, for both the top and 
bottom rocker. 

4.4 Save the settings for the first switch Click OK to save your changes. 

4.5 Copy the settings for the first switch in 
the room to any other switches in the 
room 

Right-click the second switch in the room and click 

Copy Configuration.  In the list that appears at the 
bottom, select the switch you want to copy from (in this 

case the first switch programmed above) and then 

click OK. 

Repeat for the remaining switches.  

4.6 Right-click the first KEYPAD in the 

Room, then click Edit 

This brings up the Edit Device dialog, which allows you 
to edit the settings for the keypad. 

4.7 Click the Transmit Components tab to 
map the buttons to links 

Select the link name and mode for each button (On, 
Off, A, B, C and D for a 6 button keypad and A, B, C, D, 
E, F, G, and H for an 8 button keypad). 

Mode is usually Link Activator or Toggle. A Link 

Activator turns on a link and is usually used for scene 
control in a Living Room / Dining Room area. The 

Toggle allows for on/off toggle control of a link and is 
usually used to control a single or group of lights. 

If a link appears on more than one keypad, you MUST 
set that link to the same mode (Link Activator or 
Toggle) on ALL keypads to get proper behavior. 

For the six button keypad, set the UP link to Use Last 

Link and the mode to Bright Button, and set the DN 

link to Use Last Link and the mode to Dim Button. 

4.8a For Gen1 Keypads: Click the Receive 

Components tab to map the LED 
indicators to the appropriate links 

Press the Match Link button to match the links set in 
the transmit components tab to the LED indicators in 
the receive components tab. 

For each indicator, select Do Nothing for When this 

indicator comes on. Clear all of the group check 
boxes to the right: the indicator behavior is handled 

automatically by the g! system. 

4.8b For Gen2 Keypads: Click the Receive 

Components tab to map the LED 
indicators to the appropriate links. 

Press the Copy Links button to match the links set in 
the transmit components tab to the LED indicators in 
the receive components tab. 

For each Link set the desired LED behavior, refer to the 
PCS documentation for details on making the LED 
track properly in their system. 
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4.9 Click the Options tab to view the 
available keypad options 

Select the LED Brightness as desired. Lower levels 
are preferable when the keypad is located in a 
bedroom. 

Check that LED Tracking is on.(Not required for Gen2 
Keypads) 

4.10 Save the settings for the first keypad Click OK to save your changes. 

4.11 Copy the settings for the first keypad in 
the room to any other keypads in the 
room 

Right-click the second keypad in the room and click 

Copy Configuration.  In the list that appears at the 
bottom, select the keypad you want to copy from (in this 

case the first keypad programmed above) and then 

click OK. 

Repeat for the remaining keypads. 

4.12 Right-click the first LAMP MODULE in 

the Room, then click Edit 

This brings up the Edit Device dialog, which allows you 
to edit the settings for the module. 

4.13 Click the Receive Components tab to 
view the links in which this module is 
enrolled (or the Receive Ch 1/2 on the 
two channel module) 

Enroll the module into the required links, up to a total of 
16.  For each link: 

Set the Level. Note that changing this level later while 
at the site is easy to do at the switch, so getting it 
perfect at this time is not critical. 

Set the desired Fade Rate. 

Repeat for the 2
nd

 channel if there are two. 

4.14 Click the Options tab Select the desired LED Color Control. 

If the light should not be dimmed, set Dimming to Not 

Enabled.  For switches that support dimming, set the 

Default fade rate. 

Confirm that Report light level on lamp switch 

trigger activation is checked. 

4.15 Save the settings for the first module and 
program any remaining modules 

Click OK to save your changes. 

4.16 Right-click the first APPLIANCE 

MODULE in the Room, then click Edit 

This brings up the Edit Device dialog, which allows you 
to edit the settings for the module. 

4.17 Click the Receive Components tab to 
view the links in which this module is 
enrolled 

Enroll the module into the required links, up to a total of 
16.  For each link: 

Set the Level (100 %). 

4.18 Click the Options tab Select the desired LED Color Control. 

4.19 Save the settings for the first module and 
program any remaining modules 

Click OK to save your changes. 

4.20 Right-click the first INPUT MODULE in 

the Room, then click Edit 

This brings up the Edit Device dialog, which allows you 
to edit the settings for the module. 

4.21 Click the Transmit Components tab Select the link mode: N.O. Input or N.C. Input. 

Select the link for inputs 1 and 2. 

4.22 Click the Options tab Select the desired LED Color Control. 
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4.23 Save the settings for the first module and 
program remaining modules 

Click OK to save your changes. 

4.24 Right-click the first OUTPUT MODULE in 

the Room, then click Edit 

This brings up the Edit Device dialog, which allows you 
to edit the settings for the module. 

4.25 Click the Receive Ch 1 tab Enroll the module into the required links: normally just 
Output 1, for example. 

Set the Level (100 %). 

Repeat for the Receive Ch 2 tab. 

4.26 Click the Options tab Select the desired LED Color Control. 

4.27 Save the settings for the first module and 
program remaining modules 

Click OK to save your changes. 

5 Program the remaining rooms Select the next room in the tree structure at left and 
repeat the steps in #4. 

6 Save your work Click File, Save to save your changes. 

PULSEWORX LIGHTING SYSTEM PROGRAMMING – ONLINE PHASE 

IMPORTANT NOTE: You should not program the lighting system while the g! system is also connected 

and communicating with the PulseWorx lights.  Disconnect g! from the lighting system or turn off the g! 

Controller while you make changes to the lighting system. 

Run the UPStart Setup Tool with the PIM connected to the lighting system and your computer. 

 

Step Instructions Comments 

1 Click Tools, UPB Interface to configure 
the PulseWorx interface.  

If you are connected with RS-232 to the PIM, set 

Interface Type to Powerline Interface Module (PIM-

R), and set the Communications Port to the correct 
COM port. 

If you are connected to the PIM-IP via Ethernet, set 

Interface Type to PIM-IP, and enter the IP address. 

Note you may also Run PIM-IP Discovery Program to 
locate the unit’s IP address. Note for reliability the PIM-
IP is strongly recommended to be set to a static 
address. 

Click Test: if you don’t see check marks for the items in 
the list below then stop and correct your setup 

2 Click File, Open Network File and locate 
the project file for this system 

This will retrieve all of the switches, keypads and 
settings from the offline programming phase. 

3 Program the devices in the first Room In the tree structure at left, select the first room: this will 
display all the switches and keypads from that room in 
the window to the right. 

3.1 Right-click the first switch or module in 

the window, then click Install/Replace 
This brings up the Install / Replace Device dialog. 

Put the selected switch into setup mode by tapping on 
the top rocker 5 times: the load will change state, and 
the LED on the switch will flash quickly. 

Click OK in the dialog to program the switch: when the 
programming is done, the switch is taken out of setup 
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mode, and the dialog progress should indicate that 
programming is complete. 

Each switch takes roughly one minute to program. 

Repeat for the remaining switches or modules. 

3.2 In the same room, right-click the first 
keypad in the window at right, and then 

click Install/Replace 

This brings up the Install / Replace Device dialog. 

Put the selected keypad in setup mode: for 6 button 

keypads, press the On and Off button simultaneously 
until the keypad starts to blink, for 8 button keypads, 
press the top and bottom buttons. 

Click OK in the dialog to program the keypad: when the 
programming is done, the keypad is taken out of setup 
mode, and the dialog progress should indicate that 
programming is complete. 

Each keypad takes roughly one minute to program. 

Repeat for the remaining keypads in the room. 

4 Program the remaining rooms Select the next room in the tree structure at left and 
repeat the steps in #3. 

OTHER PULSEWORX FEATURES 

In addition to the steps and settings listed above, there are other features available in the PulseWorx 
system that may be useful in certain situations.  A few are listed here as examples: 

DOUBLE-TAP BEHAVIOR 

Each switch can be setup to send a link when the rocker is double tapped.  This can be helpful to add a 
function at a location without the need for a separate keypad. 

Consider pathway lighting from the front door to the garage.  A keypad is installed at the garage door, 
because that door is most commonly used.  No keypad is installed at the front door to minimize wall 
clutter.  When someone taps the switch by the front door, the light in the entry goes on.  When they 
double-tap the switch at the front door, all of the pathway lighting to the garage is turned on. 

CHANGING LINK (SCENE) SETTINGS (MANUAL) 

After the system has been programmed, the user cannot make changes to the system from the keypads if 
the change requires that a new load or light be included in a scene, or that an existing load be removed 
from a scene. 

On the other hand, if the customer simply wishes to change the dim level for the existing loads in a scene, 
then this can be accomplished as follows: 

1. Press the scene button that should be changed 

2. Set all the lights in the scene to their new desired settings 

3. Tap the scene button on the keypad five times: the indicator will start to blink 

4. Do not tap any other light switches or keypads, and wait for the indicator to stop blinking  
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g! CONFIGURATION NOTES 

READ CONFIGURATION FROM A UPE FILE 

When you have completed programming in UPStart and are ready to attach the PCS system to the g! 
System for control, you may export a UPE file from UPStart to read into the g!System. To export a file: 

1. Program the ELAN/PCS Lighting in the UPStart Software 

2. Select File -> Export 

 

3. Save the file to your PC. It is recommended to include the date and customer in the filename. 

 

4. Open the g!Configurator and navigate to the Lighting tab 

a. Add the PCS Lighting Interface as described in g! Configuration Details (if you have not 
already done so). 
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5. Select the Read Config File button  

 

6. Locate where the upe file from UPStart was saved and select Open 

 

7. Select OK when the upe file is finished loading 

 

8. Setup the g!User Interfaces in the Interface Tab as desired and verify operation in the g!Viewer 
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ADD A SINGLE PCS DEVICE 
If a single PCS device was added after adding PCS to the g! System, it is possible to add a single device 
to g! without Discover Devices or Read Config File.  

1. Program the device completely in UPStart. 

2. Note the UPB device ID number. 

3. Enter Configurator, and right-click an existing device. Choose Discover New Device. 

4. Enter the UPB ID for the new device and click Discover.  
5. If found, the device will read in from the network and add the correct type of device to Configurator 

and associate with appropriate Links. Status is shown on the bottom of Configurator. The device 
many now be used normally. 

PCS CUSTOMIZABLE SCENES 

With g! version 6.5, PCS Links may be edited from the Viewer using the PCS Customizable Scene 
feature. In this situation, a PCS Customizable Scene is created and associated to a PCS Link number for 
either an existing PCS link, or new (with a previously unused Link number). A Customizable Scene button 
may then be associated with the PCS Customizable Scene, and the link may be edited in the same 
fashion as a generic g! Customizable Lighting Scene. Note that during installation the dealer must 
Configure the PCS Customizable Scene in Configurator and build the Custom Page for the Customizable 
Scene button to allow Viewer customization by the dealer or homeowner.  

Devices Variable Name Setting Comments

Customizable Scenes Add New Scene <Select>

Add new Customizable Scene Name <User Defined> (Default: New Lighting Scene)

Type <Select> PCS Lighting Scene

System <Select>PCS Lighting Interface

Link # <User Defined>

Enter a unused link number to create a new custom scene, or enter an 

existing link number to modify an existing link. 

Custom Pages Add New Custom Page <Select>

Custom Page Add new Control <Select>Light Scene Button Customizable

Light Scene Button Customizable Name <User Defined>

Connect To <Select> Connect to the desired PCS Customizable Scene

Viewer Tap to activate Customizable Scenes are activate only

Press and hold to edit scene Changes are written as they are made to the PCS system

Note that any modified or added Links will not appear in your UPStart file 

unless you read in changes from the network  

 

Note: Any links edited or created by g! will not be present in your UPStart file. 

Elan recommends doing the “Network>Read All” feature from UPStart the next time you use UPStart to 
incorporate any changes made from the g! system. 
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g! CONFIGURATION DETAILS 

The following table provides settings used in the g! Configurator.  Please refer to the Configurator Reference Guide for more details. 

o “<Select>”    Select the appropriate item from the list (or drop-down) in the Configurator. 

o “<User Defined>”, etc.   Type in the desired name for the item. 

o “<Auto Detect>”, etc.   The system will auto detect this variable. 
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Devices Variable Name Setting Comments

Communication Devices Name <User Defined> (Default: Lighting)

Type Serial Port or Ethernet Choose correct type for the PIM you are using. PIM-R uses RS-232, PIM-IP uses Ethernet.

Communication Type Standard

Location <User Defined> (Not Required)

Com Port or IP Address <Select> or <User Defined> Pick the Com port you are using (PIM-R). Enter the correct IP address (PIM-IP).

Lighting Interfaces Name <User Defined> (Default: PCS PIM)

Device Type PCS PIM Serial,  PCS PIM IP, OR PCS PGW Pick the appropriate device type for the type of PIM installed

Network Password <User Defined> (Default: 1234)

Enter the correct network password as defined in UPStart Network Properties. Required for 

PCS Customizable Scene Feature

COM Device <Select> (Default: Lighting)

Network ID <User Defined> (Default: 1) The Network ID must match the Network ID in UPStart

Settings <User Defined> (Default: Disable Multi-Packet) See Note 1

Lighting Devices

<Read Config File> Click the "Read Config File" button and navigate to the exported UPE file. Configurator will automatically populate all supported devices and links.

OR
<Discover Devices> Click the "Discover Devices" button on the lighting interface  in the Configurator to automaticly discover devices configured in UPStart. (Not needed if you read in a config file)

Name <Auto Detect> This is the Name from UPStart, it can be changed if desired

Device Type <Auto Detect> The device type as discovered (see note 2)

Hide Device from Scheduler <Select> This option will hide or show the device on the shedule tab

Disable LED Management(keypads only)<Auto Detect> Set this to No for Gen1 keypads and Yes for Gen2 keypads

Location <Auto Detect> This is the Room from UPStart (See Note 3, 4)

Unit Number <Auto Detect> PCS unit ID #

Inputs / Outputs

Input Name <Auto Detect> The name of each input can be changed

Device ID <Auto Detect> Input 1 or 2 on the ICM

Output Name <Auto Detect> The name of each output can be changed

Interface Device <Auto Detect> Output 1 or 2 on the OCM

Notes:

1. Multi-Packet mode is supported only by Gen2 PCS devices, and is required if using SPR/TPR devices. Note that Multi-Packet must be DISABLED during Device Discovery. See additional info below

2. If the device type is Unidentified PCS device, contact Elan tech support for assistance

3. The g! system reads the Room value from the switch and displays it in the Location field.

4. The light switches are sorted in the Configurator by Room, and then by Unit Number.

Notes:

<The inputs and outputs from ICM or OCM modules appear on the Input / Output tab>
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UPB MULTI-PACKET MODE AND SPR/TPR DEVICES 

Core Module 4.0.1621 or later required 

Gen2 PCS devices and g! support the use of UPB products in Multi-Packet mode. In this mode, UPB 
devices will repeat all transmissions 1-4 times (depending on settings). This mode can be very helpful in 
situations with high noise or long distances in between devices. In addition, this mode is required for use 
of Split-Phase or Triple Phase Repeaters in a UPB system.  

g! supports Multi-Packet mode for control and feedback of a UPB system, however it cannot Discover 
Devices from the network in this mode. To Discover Devices in g! you must disable Multi-Packet on the 
PCS/Simply Automated interface and discover one phase of the install at a time as described below. This 
process is not required with PPC (Phase Coupler) devices, and only is required with active repeating 
SPR/TPR devices. 

1. Install all devices including SPR/TPR device, and program in UPStart per standard PCS 
documentation in preparation for integration with g!. Note that Multi-Packet should be enabled by 
default in UPStart for all installs with SPR/TPR devices, but you may verify this setting by editing 
device properties and checking the Advanced tab under Transmission Attempts. 

2. With appropriate circuit breakers disabled in regard for your safety, disconnect the SPR/TPR 
device and remove it from the install. 

3. Locate outlets on each phase of power in the install to attach the PIM-R to. It may be helpful to 
use a heavy duty extension cord to attach the PIM to different outlets. 

4. Discover the 1
st
 Phase devices: 

a. Power up the appropriate breakers (if disabled earlier). 

b. Attach the PIM to an outlet on the 1
st
 Phase of power, and to the g! Controller (via serial). 

c. In Configurator, ensure that Settings: Multi-Packet is DISABLED. 

d. Discover Devices. 

e. Wait for all devices on this phase of power to be discovered into Configurator. 

5. Move the PIM to an outlet on the next phase, and Discover Devices in Configurator to discover all 
UPB devices on the 2

nd
 Phase as above. 

6. If there are 3 Phases in the install, move the PIM to an outlet on the 3
rd

 phase, and repeat 
Discover Devices to discover all devices on the 3

rd
 phase as above. 

7. Move the PIM back to the desired permanent install location. 

8. With appropriate circuit breakers disabled in regard for your safety, install the SPR/TPR device 
back on the network per PCS standards. 

9. In Configurator, change Settings: to Multi-Packet Enabled. g! is now ready to control your Multi-
Packet devices on all phases. Note that if any changes are made to the network in UPStart, you 
will need to repeat the above steps to learn any new settings into the g! software. 
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COMMON MISTAKES 

1. Installing UPB in the same building with Lutron HomeWorks, RadioRA or GRAFIK Eye systems.  The 
power supplies that Lutron manufactures create noise on the power line that interferes with UPB 
communications.  Contact Elan or PCS for suggestions to minimize the noise if you need to make 
both systems work together. 

2. Installing UPB with noisy dimmers.  Some standard 120V dimmers, when set to very low brightness, 
will create noise on the power line that can interfere with UPB communications.  Contact Elan or PCS 
for suggestions to isolate the noise from noisy dimmers.  

3. Failing to properly program the PCS devices from UPStart PRIOR to discovering the system in g!.  
We strongly recommend fully designing and programming the lighting system in UPStart prior to 
discovering the system into g!.  This will save a lot of time not going back and forth between UPStart 
and g!. 

4. Insufficient UPStart version for device support. Check you have the latest UPStart if desired devices 
are not available for addition. PIM-IP/KPC7 required version 6 build 29 at time of writing. 

5. Communication Issues. PCS PIM-R devices can sometimes report “Error: Could not put PIM in 
PULSE mode” when attempting discovery from the g! system. If you encounter this issue, check the 
following: 

 Bear in mind the PIM is not compatible with Global Cache com ports. 

 Network ID set in Configurator to match UPStart. 

 Known good, straight-through serial connection: tested adapter and cable, with cable of 
appropriate length (typically less than 50ft). It is especially helpful if the same cable that was 
used to program UPStart is used when integrated with the g! controller to rule out odd cable 
problems. 

 Verify correct connections and serial port settings. 

 If using an HC Controller, it may be helpful to use Com 1 or 2 on the HC. 

 The PIM should be located in a standard outlet, and power strips/surge strips should be 
avoided whenever possible for best power line communication. 

 It is possible to put away the PIM “uncleanly” if you exit UPStart without going “offline” first.  

i. You may wish to re-connect to UPStart and ensure proper disconnection from your 
PC to leave the PIM in the correct mode. 

ii. Alternatively, it may be helpful to disconnect all serial cables from the PIM, and power 
cycle it by removing it from the outlet for a few seconds. Once it has fully powered up 
(watch LED to stabilize), then reconnect the serial cable and try again. 

iii. Reset the PIM to default: 

 Gen2: Push-button: The push-button on the front of the PIM-R is used to put 
the device back to its factory default condition. To set the PIM-R back to 

factory defaults first press the pushbutton 5 times rapidly. The Status LED will 

blink blue. Next, press the pushbutton 10 times. The Status LED will blink 

red. Finally, press the pushbutton 2 times. The Status LED will stop blinking. 
The device is now restored to its factory default state. 

 Gen1:  Push-button: The push-button on the front of the PIM-R is used to 
put the device back to its factory default condition. To set the PIM-R back to 

factory defaults first press the pushbutton 5 times rapidly. The Status LED will 

blink green. Next, press the pushbutton 10. The Status LED will blink red. 

Finally, press the pushbutton 1 time. The status LED will become solid 
amber. The device is now restored to its factory default state. 



26 of 26 

6. Cannot communicate with PIM-IP. Note the PIM-IP only supports a single connection.  

 If you cannot communicate with g!, check UPStart is not still in Online mode with the PIM. 

 If the g! controller is locally shut down, such as removed power cord, or turned off on the face 
of the unit, and the PIM itself did not lose power, it is possible the PIM still has the previous 
socket open. Power cycle the physical PIM-IP unit to make it ready to communicate again. 

 If you still cannot communicate, check the IP address is correct and the PIM-IP is online using 
the PIM-IP Discovery feature in UPStart.  

 Verify all settings in Configurator are correct. 

7. Customizable scene does not modify/add devices to links. 

 Check the correct link number is used in the PCS Customizable Scene, and the Customizable 
Scene button is linked to the correct PCS Customizable Scene. 

 Check the device is available and online (unplugged Lamp module etc.) 

 Check the Network Password provided in Configurator is correct. If this field is not accurate, 
Elan cannot write changes to the PCS network.  

 


